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Note: Course Genie operates only with MS Word under the Windows operating system.  It does not operate with the Macintosh operating system. However, if you have a Macintosh supporting the dual operating systems (both Mac OS and Windows) you can use Course Genie with MS Word when in the Windows mode.

Using “Links” in this document

[image: image11.jpg]To activate any links (blue underlined items) in this MS Word document, hold down the Control key while clicking on the link (Ctrl + Click).
Prerequisites:
Before registering for workshops, please review these prerequisites
· Experience with using MS Word – MS Word 2007 is currently used in the classroom.
· Experience with using either MS Internet Explorer or Firefox web browsers.

· ITD’s general prerequisites on line at:
http://www.ncsu.edu/it/education/faculty-staff/pre-reqs.php
· Verify that your Unity ID and Password is currently active and that you have access to your personal AFS space by using the following services:

· Check your Unity ID and Password to see if they are currently active. 
To do this, use a Web browser to go to http://www.ncsu.edu/password/ . Enter your Unity ID on the first line and re-enter your current password in each of the three spaces provided. Click on Change Password.  If an error message is returned, try it again or ask the instructor for assistance.
· Use the WWW Setup Tool to prepare your personal AFS file space for web pages and to authorize Internet access for viewing of your personal Web Site. To do this, use a Web browser to go to:
http://www.ncsu.edu/it/essentials/web_pages/www4_setup.html.
Note: You must have an active Unity ID/Password to use the WWW Setup Tool. 

If you have any technical problems contact the NC State Help Desk at 515-HELP (4357) or email to help@ncsu.edu. 
If you have any questions about the class or its prerequisites contact classreg@ncsu.edu.
Objectives

After completing this workshop you will be able to:

· Obtain a copy of Course Genie.

· Format an MS Word document using Course Genie features.

· Know how to use Course Genie to generate web pages or eLearning content.

· Use Course Genie to generate well-structured web pages or eLearning content.

· Use Course Genie to ensure that content, images, multimedia and data tables in generated web pages meet Section 508 accessibility standards.

· Recognize the major capabilities as well as the limitations of Course Genie.

· Move the files from the classroom computer to your personal AFS web space.

· View the web sites on the Internet through a web browser.

If you are interested in learning and applying Course Genie for classroom content, see the workshop schedule for DELTA / Learning Technology Applications at:

http://delta.ncsu.edu/learn/workshops/catalog/ 
Getting Started

Welcome to the Avent Ferry Training Facility (AFTF) and it’s Computing Environment

· Directions to Room 37, ITD’s Avent Ferry Training Facility, is available at:
Avent Ferry Training Facility (AFTF) 

· Several WolfLine bus routes provide service to the Avent Ferry Complex. See:
WolfLine 

· “C” and “F” parking spaces are available behind the building.

The computing environment in AFTF is

· Windows based Personal Computers running Windows XP set up with a modified version of the Unity Labs configuration using the Novell Applications Launcher (NAL).

· Be sure to Logout before leaving. Use the red Logoff icon on the Desktop.
· Do not turn computers off.  We leave them powered on at all times.
Logging on
1 Press CTL + ALT + DEL and log on using your Unity ID / Password.
2 If you have trouble with your password, use a web browser on the instructor’s computer to go to http://www.ncsu.edu/password, enter your Unity ID and re-enter your current password in each of the three spaces provided.
Open a web browser. 
Start Internet Explorer from either:

1 The computer’s Desktop 
2 From Start / Internet Explorer
3 The Novell Application Launcher (NAL).
Set up your personal file space for web pages

If you haven’t already done so, use the WWW Setup Utility to set up your personal www directory so it works properly with our web servers, provides space for your web pages and allows anyone on the Internet to access them - for “viewing” only.
1 To use the WWW Setup Utility, copy the following address into a web browser and go to:
https://sysnews.ncsu.edu/tools-bin/www-setup
2 Use your Unity ID / Password to Login. 
3 Afterwards, your personal web space will be accessible - for viewing only - by anyone on the Internet via the following URL:
http://www4.ncsu.edu/~yourUnityID
Getting a copy of the files for today’s workshop
1 Open My Computer – it’s called “aftnn” on the computers in the classroom. The identification number for the computer you are using is located at the top of your monitor, aftnn, (aft01, aft02…..aft15, aft16). The icon for starting my computer may be located on upper left of your computer’s Desktop. If it’s not there, you may find it by clicking on Start then look for your computer’s identification aftnn number in the upper part of the right column.
2 Double click on the I drive – it should be the first drive listed under Networked Drives. If you have trouble finding the “I” drive, click on View / Details on the menu bar.  It should be listed as Dept on’Itd_dept_server’(I:).
3 Double click on the ITD folder
4 Find the folder named CourseGenie (I:/ITD/CourseGenie). 
5 Single click on the CourseGenie folder and drag it to your Desktop. This copies all of the files you will need for today’s workshop on to your computer’s Desktop.
6 Verify that you now have a CourseGenie folder on your computer’s Desktop.
7 If you do, Close my computer. If you don’t, ask the instructor for assistance.
Starting MS Word
1 From the Novell Application Launcher (NAL), double click on the Word 2007 icon (in the Microsoft group, Microsoft Word 2007). 
2 If a message appears asking if you want to “Enable Macros”, click on the Enable check box (there must be a check mark in the box) then select Yes Enable Macros. Course Genie requires the use of Macros. The Macro feature must be turned on in Word to use Course Genie.
Opening an electronic copy of the handout for today’s class
1 Using MS Word, open the handout-2007-update.docx located in the CourseGenie folder on your Desktop.
2 This is an electronic copy of the paper handout.  The key difference is that you can use the links on the electronic version. 
Finishing the Workshop

1 Before you leave, please complete the class evaluation form.  Double click on the “Workshop online evaluation” icon on your Desktop.

2 After completing the evaluation, Log Out using the (RED) Logout icon on the Desktop.

3 Do NOT turn the computers off. We keep them powered on at all times.

Where to get Course Genie

NC State has a license that allows for the distribution of Course Genie, at no charge, to anyone with an active Unity account. To download a copy, go to:
http://ncsu.edu/it/access/software/coursegenie/index.php/
Course Genie web site:
http://www.wimba.com/products/coursegenie/ 
CourseGenie Demos:

http://www.wimba.com/demos/ 
Where to get MS Word
NC State has agreements which allow colleges, departments, students, faculty, and staff to obtain MS Office products. For more information go to:
http://www.ncsu.edu/software/available-software/product.php?software=86 
Microsoft Office products are also available at NC State Bookstores. For more information go to:
http://www.fis.ncsu.edu/ncsubookstores/software.html#microsoft 

Your department may also have arrangements for obtaining Microsoft Office products. Contact you technical support staff or go to:
http://help.ncsu.edu/otherhelp.php 
Accessibility

Web pages must be made accessible to persons with disabilities.

The NC State Web page accessibility regulation requires, as a minimum, compliance with Section 508 of the Rehabilitation Act. The requirements apply to "any item, piece of equipment, or product system, whether acquired commercially off the shelf, modified, or customized, that is used to increase, maintain, or improve functional capabilities of individuals with disabilities.” This means that our web pages must be accessible to persons with disabilities.
Accessibility is not only about supporting disabled visitors, even if that is one of the most important reasons for making a website accessible.  An accessible website works better for everybody, disabled or not, and can be accessed by more people with more kinds of web browsers and other browsing devices (user agents).  An accessible website is accessible and usable for everyone, regardless of what hardware and software they are using, and regardless of what they use to navigate on the site.

For more information on Accessible IT at NC State or if you need assistance complying with IT accessibility requirements, see:
http://www.itd.ncsu.edu/access/ 


Technical training is available for accessibility features in web pages, MS Word and PDF documents. Contact:

· For ITD Training Services, classreg@ncsu.edu
· For DELTA Instructional Services, learntech@ncsu.edu, or

· Contact your technical support staff or your departmental help desk http://help.ncsu.edu/otherhelp.php 

Starting Course Genie  
1 If not already running, start MS Word. Course Genie is an editing feature that is added to MS Word. 
2 To verify that Course Genie is installed on your computer, from within Word, select the Add-Ins tab then look to see if Course Genie in listed as one of the Add-Ins in the Menu Commands section - at the far left. If it is there, then Course Genie has been installed and available for use.  If it is not there, it needs to be installed.
3 Course Genie cannot be started until there is a document open in Word.

4 Open the Weather.doc file. Office Button > Open and navigate to the CourseGenie folder on your Desktop and select the Weather.doc document.
5 To start CourseGenie, from the MS Word main menu, click on the Add-Ins tab then the Course Genie > Start Course Genie in the Menu Commands section.
Note: Course Genie uses Word Macros. If Course Genie does not start, it may be due to Word Macros not being enabled. To enable Word Macros:
1- Click on the Office Button
2- Click on the Word Options button (at the bottom)
3- In the (lower) left column, select Trust Center
4- Click on the Trust Center Settings… button (lower right)
5- In the left column, select Macro Settings
6- Under Macro Settings, click on the radio button (turn on the last option) 
     Enable all macros (not recommended; potentially dangerous code can run)
7- Click on OK (at the bottom)
8- Restart word – The macros will not be activated until Word is restarted.
    Close Word then re-start Word.

9- Open the Weather.doc (again)
10- Start CourseGenie, from the MS Word main menu, click on the Add-Ins tab then the    Course Genie > Start Course Genie
6 If the Course Genie welcome pop-up appears, just click on OK to close it.
7 When the program has started, you will see two CourseGenie drop-down menus on the Add-In tab.  Usually on the right end of the menu bar.
8 Course Genie will stay on until you either close Word or close Course Genie by selecting Add-Ins  > Course Genie > Stop Course Genie.
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Turning on Styles

Course Genie uses applied Styles to format web pages.

1 On the Home tab, click on the arrow box [image: image2.png]


 at the bottom left of the Styles group. 
2 The vertical styles menu should now appear as a floating window.
3 The styles that begin with cg are designed to be used by Course Genie to format documents for web pages.
We are now ready to start some exercises.  

Any questions?

Exercise 1 – Creating a new web site with a single web page from the “Weather.doc” document 
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Info: Exercises 1 will create a new web site named Weather-1. It will be stored inside the CourseGenie folder on your Desktop. Exercise 2 will add additional pages in the Weather-1 web site.
Open the Weather.doc.

To do this:

1 If not already open, open the Word document called Weather.doc. To do this:
Select Office Button > Open and navigate to the CourseGenie folder on your Desktop and select the Weather.doc document.
2 Now, save it in your CourseGenie folder on your Desktop with a different name. To do this:
Select, Save As…, in the CourseGenie folder on your Desktop, and assign it the file name 
Weather-1.doc.
This keeps the original file (Weather.doc) safe. You can use it as a backup if you ever need to go back to the original. 
3 Once a word document is marked up by Course Genie, it may be difficult to recreate the original. When converting Word documents to web pages using Course Genie make it a habit to work from a copy. You can never tell when you might need to go back to the original.
Making a web page from “Weather-1.doc”.

To do this:

1 The Weather-1.doc document should be open. If it is not open it in Word.
2 Click on the Add-In tab.
3 In the Menu Commands group, select CourseGenie (there are two, select the one with the command options), then click Generate Course.
4 The Browse to folder window will open. This allows you to select where you want the web site and it’s web page(s) and supporting files to be saved. It should default to the Desktop / CourseGenie folder. Don’t change it. This is the correct place where we want to save the work for today’s workshop. 
5 Click on OK.
6 Course Genie will now create a new web site and a single web page from the 
Weather-1.doc Word document.
7 After the process is completed, a report of what Course Genie accomplished will be presented including the names of all the folders and files that were created.
8 At the bottom of the dialog box there is a check box for Preview in browser. Be sure to place a checkmark in this box.  Most people then just leave it on.
9 Click on Close.
10 The web page “Index.html” generated from the Weather-1.doc should now be presented in a web browser window.  The “Index.html” web page is the “home” page for the web site.
11 Look it over.
12 Notice that the title of the web page is Climate and Weather. We’ll change this in the next exercise.
13 Also notice that there is no navigation on the web page. 
   - No navigation list on the left. 
   - No Forward button.
   - No Next button.
   - No Home button.
None of these navigation aids are needed because there is only the single web page.
We’ll do something about this in the next exercise.
Back to the Weather-1.doc Word document

1 Close the Browser window. Course Genie prefers that you close the browser window after each preview.  If you leave it open, you may get a warning message the next time you generate the page.
2 You should now be back in Word and viewing the Weather-1.doc.

3 Notice a change at the top of the page.
   Metadata has been added.
Metadata is used by web browsers to control the presentation of web pages and by search engines to help locate the web page. Except for the title, Metadata is usually not seen when viewing the web page through the browser screen.
4 You can edit the Metadata directly in the document or by selecting the CourseGenie menu commands (on the Add-Ins tab) then selecting Metadata…. We could have added the Metadata before we generated the page. It’s up to you when you want to either add or modify the Metadata.
5 Let’s take a minute to change some of the Metadata.
6 Select the top CourseGenie menu commands on the Add-Ins tab then select Metadata….
7 Change the Title to Your Name’s Weather Web Page
8 Add a Description - a brief narrative of what the web page / web site is all about.

9 Add some Key Words – a list of key words (separated by commas) used within the web page / web site or words that will help search engines find the web page.
10 Select the Rights tab and 
11 For the Author, add your name.
12 For the Organization , add NC State University.
13 For Copyright , add Copyright NC State University, 2007.
14 Click on OK 
Note: These changes could have been made directly in the Metadata section of the document.  Either way accomplishes the same thing.
15 Generate the revised web page by clicking on the top CourseGenie menu commands on the Add-Ins tab then select Generate Course…
16 Leave the Browse to folder to the default. It should still be the CourseGenie folder on your Desktop. 
17 The updated page will now be generated.

18 Preview it in a browser.

19 See any changes? The only thing that should be visible is the new title.
20 Close the browser window. Return to Word.
21 Save your work. Office Button > Save or (Ctrl + S)
You have successfully created a new web site, Weather-1, and created and updated a single web page from the Weather-1.doc document using MS Word and Course Genie.  Everything else will be doing is nothing more than further expanding and enhancing this process.
This completes Exercise 1, Creating a new, Weather-1” web site with a single web page starting from the original “Weather.doc”.

Any Questions?
Exercise 2 – Creating multiple web pages in the “Weather-1” web site from the “Weather-1.doc” document 

One of the differences between reading paper documents and web pages is that people usually like to rapidly scan web pages for something they are interested in.  If they don’t find it quickly, they go elsewhere. It’s also more comfortable reading paper documents than it is reading from a screen. Reading becomes more tiring when reading from a screen. So, they don’t stay on web pages very long. To keep people interested in your web pages, it’s usually better to break a document into multiple smaller web pages, for faster scanning, and add some navigation to help them move from topic to topic.

In this exercise, we are going to restructure the web site from a single web page into multiple web pages and add some navigation. Actually, Course Genie will do all of this for us.
The Weather-1.doc should still be open. If it is not, open it in Word.
To restructure the document, to make multiple web pages we need to add a mark-up style called cgPageTitle to each part of the document that we want to become a separate page.
Adding cgPageTitle

To do this:
1 In Weather-1.doc Word document, select the first heading, Introduction.
2 With Introduction selected, go to the floating Styles window and look for the cgPageTitle option. 

3 Apply the cgPageTitle style to the Introduction line by selecting (clicking) it from the styles list.
4 The Introduction line should now be highlighted in blue. 

5 Repeat this for all the other headings in the document; Learning objectives, Climatic maps and Definitions.
6 All of the headings lines should now be highlighted in blue. 
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Info: Page breaks added through MS Word will not affect the generated output, but you can insert them wherever you want in order to make the Word document more readable.
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Tip: The F4 key is a standard Word shortcut to repeat the last action. This means you can apply the cgPageTitle style to the first heading in the normal way, then select each of the other headings and simply press F4.

Generate the web pages
Now generate the web pages to see the effect of your applying cgPageTitle (page breaks).

To do this (It’s just like we did in Exercise 1):

1 On the Add-Ins tab in the Menu commands option select the top CourseGenie option.

2 Select Generate Course…
3 The Browse to folder window will open.  This allows you to select where you want the web page(s) and supporting files to be saved. It should default to the Desktop / CourseGenie folder.  Don’t change it. This is the correct place where we want to save the work for today’s workshop. 
4 Click the OK button.

5 Course Genie will now create multiple web pages from the modified Weather-1.doc Word document.
6 After the process is completed, a report of what Course Genie accomplished will be presented including the names of all the files that were created. Notice, there are now more web pages listed.
7 At the bottom of the dialog box is a check box for Preview in browser. Be sure to place a checkmark in this box. 
8 Click on Close.
9 The web Index.html page generated from the Weather-1.doc should now be presented in a web browser window. The “Index.html” web page is the “home” page for the web site. More on this later.
10 Look it over.
11 Notice the differences. The navigation to the four web pages should now be added.
12 Also, notice that there is navigation on all of the web pages.
13 In your browser, navigate through the new pages using both the left navigation and the navigation buttons.
14 After previewing the generated web pages, Close your browser. Course Genie does not like to generate modified pages while an existing version is still open in your browser. If you do not close the browser window, you may get a warning message the next time you try to preview the site.
15 In Word, save your work. Office Button > Save or (Ctrl + S)
Modifying the web pages

On your own -if you would like to modify the content of the Weather-1 document or it’s Metadata, feel free to do so and regenerate the web pages to see the changes.

You have successfully created and updated multiple web pages from the Weather-1.doc Word document using Course Genie.

Close the Weather-1.doc document. We are finished with it.

Leave Word open. We’ll need it for the next exercise after the break.

This completes Exercise 2, creating multiple web pages in the “Weather-1” web site from the “Weather-1.doc”.

Any Questions?

Preparing for the break

If you are worried about someone else accessing your computer while you are out of the room, you can lock it.

1 To lock your workstation:

· Press Ctrl + Alt + Del
· Select the Lock Workstation button.
· The workstation will now be locked until you are ready to unlock it.

2 To unlock your workstation:

· Press Ctrl + Alt + Del
· Enter your Unity Password in the Password area.

· The workstation will then be ready for use.
Let’s take a 10 minute break.
Welcome back for the second half.

For the remainder of the workshop, we are going to open a new document, apply a variety of styles and add some more structure, check tables for accessibility compliance, add some images and their descriptions, add some external links and add an internal link. We’ll wrap it up by copying the workshop files into your personal web space and learning how to view them from a web browser.
Exercise 3 – Creating another new web site and it’s web pages from the “Earthquakes.doc” Word document 


Info: Exercises 3 will create a new web site named Earthquakes-1. It will be stored inside the CourseGenie folder on your Desktop. The remaining exercises will either add additional pages or modify existing pages in this “Earthquakes-1” web site.
Open the Earthquakes.doc.

To do this:

1 Using Word, navigate to the CourseGenie folder on your Desktop and open the Word document called Earthquakes.doc.
2 Save it to your CourseGenie folder on your Desktop with a different name. e.g., Save As…  > Earthquakes-1. This keeps the original file (Earthquakes.doc) safe. You can use it as a backup if you ever need to go back to the original. 
3 Once a word document is marked up by Course Genie, it’s difficult to recreate the original. Make it a habit to work with a copy. You can never tell when you might need the original.
4 Be sure to start Course Genie, (Add-Ins / Course Genie / Start Course Genie). If the small CGTools tool bar pops up, you can close it. 
5 Be sure the Styles window is showing. On the Home tab, click on the arrow box [image: image4.png]


 at the bottom left of the Styles group.
Turn off accessibility checking
The Earthquakes-1.doc file contains several items that do not comply with accessibility requirements. To keep Course Genie from stopping us during our initial work on these exercises, we’ll need to turn off the Accessibility Checking feature. We’ll turn it back on, and leave it on, later.

To do this:

1 Go to the top Add-Ins > CourseGenie commands menu tab and choose Settings.

2 In the Settings dialog box, choose the Accessibility tab.
3 Remove the check mark from the Make sure the Accessibility Check checkbox.
4 Click OK to close the dialog box.
Adding cgPageTitle to break the document into multiple web pages
To do this (just like we did in Exercise 2):

1 In Word select the first heading in the Earthquakes-1.doc, All About Earthquakes.

2 With All About Earthquakes selected, go to the Styles panel  and look for the cgPageTitle option. 

3 Apply the cgPageTitle style to the All About Earthquakes line by selecting (clicking) it from the styles list.

4 The All about Earthquakes line should now be highlighted in green. 

5 Do this for all the additional 13 headings in the document; Earthquakes, Origin of Earthquakes, Seismology, The Study of Earthquakes, Types of Seismic Waves, All about Glaciers, Glaciers, Definition of Glaciers, Glacier Speeds, The formation of Glacial Ice, Changes in Glacier Size, Additional Glacier Resources, and Flash Animation of an Earthquake. Don’t forget, you can use the F4 key.
6 All 14 of the headings lines should now be highlighted in green.
Adding Metadata

1 From the Add-Ins tab select CourseGenie.
2 From the CourseGenie commands menu, Select Metadata.

3 Select the Description tab.
4 For the Title, enter Earthquakes and Glaciers.

5 For the Description, enter Geology 101, Introduction to Earthquakes and Glaciers.

6 For the Keywords, enter Geology, Earthquakes, Seismology, Glaciers
7 For the Objectives – leave it blank for now.

8 Select the Rights Tab

9 For the Author, enter your name

10 For the Organisation, enter NC State University / OIT Course Genie Workshop
11 For the Copyright, enter All rights reserved, NC State University, 2007

12 Click on OK
13 Save your work. Office Button > Save or (Ctrl + S).
Making web pages from Earthquakes-1.doc
To do this:

1 The Earthquakes-1 document should still be open. If it is not open it in Word.

2 On the Add-Ins tab in the Menu commands option select the top CourseGenie commands menu.

3 Select Generate Course…
4 The Browse to folder window will open. This allows you to select where you want the web page(s) and supporting files to be saved. It should default to the Desktop / CourseGenie folder.  Don’t change it. This is the correct place where we want to save the work for today’s workshop. 
5 Click on OK.
6 Course Genie will now create the web page from the Earthquakes-1.doc Word document.
7 After the process is completed, a report of what Course Genie accomplished will be presented including the names of all the folders and files that were created.
8 Notice that at the bottom of the dialog box is a check box for Preview in browser. Be sure to place a checkmark in this box. 
9 Click on Close.
10 The Index.html web page generated from the Earthquakes-1.doc should now be presented in a browser window. Look it over.
11 Notice that the title of the web page is Earthquake.
12 Also notice that there is navigation on all of the web pages. 
13 In your browser, navigate through the new pages using both the left navigation and the navigation buttons.
14 Close the browser window and return to the Earthquakes-1 .doc in Word.
15 Save your work. Office Button > Save or (Ctrl + S).
Adding more structure to the web site

Let’s break the web site into multiple sections (like chapters in a book). We’ll group all the information about earthquakes together, all the information about glaciers together and create a section for references.

To do this we need to add a mark-up style called cgSectionTitle to each part of the document that we want to become a separate section.
To do this:

1 With the Earthquakes-1.doc document open on Word.
2 Add a new line just above the heading All about Earthquakes. Just below the Metadata box. Caution: Do not make any changes inside the Metadata box at this time.
3  Type in Earthquakes
4 Apply the cgSectionTitle style to the new line, Earthquakes.
5 The Earthquakes line should now be highlighted in orange.
6 Add a new line the just above the heading All about Glaciers. Type in Glaciers.
7 Apply the cgSectionTitle style to the new line, Glaciers.
8 The Glaciers line should now be highlighted in orange.
9 Add a new line just above the heading Additional Glacier Resources. Type in Additional Resources.
10 Apply the cgSectionTitle style to the new line, Additional Resources.
11 The Additional Resources line should new be highlighted in orange.
16 Generate the modified web site Add-Ins tab > CourseGenie > Generate Course.
17 Preview it in a browser.
18 Notice any differences – Look at the left navigation.
19 After you review the web pages, Close the browser window and return to the Earthquakes-1.doc in Word.
20 Save your work. Office Button > Save or (Ctrl + S).
You now have a well structured web site.
This completes Exercise 3, creating the “Earthquakes-1” web site and its web pages from the “Earthquakes-1.doc”.

Any Questions?

Exercise 4 – Modifying the look of the “Earthquakes-1” web site
Add a new footer and change the design scheme

We’ll use the CourseGenie > Settings dialog box to add custom footers on each page and to change the design scheme of the generated pages.
To change the footer for all the pages, do this:

1 Go to the Add-Ins Tab and select the CourseGenie commands menu and choose Settings.

2 In the Settings dialog box, choose the General tab.
3 Enter the text for a new Footer. 
4 Type in Web site built by your name. 
5 Generate the course again and preview the modified pages.
6 Close the browser window.
To change the design scheme, do this:

7 Go to the CourseGenie commands menu on the Add-Ins tab and choose Settings.

8 In the Settings dialog box, choose the General tab.
9 Choose a different design from the Scheme dropdown list. 
Note: Some of the schemes will add a Curse Genie Logo to the design layout. There is a way to substitute their image with your image. But we do not cover this in this class. Try to select one without their image. You won’t know until you generate the updates.
10 Click OK to close the dialog box. 
11 Generate the course again and preview the modified pages.
12 Close the browser window.
13 If you do not like the scheme you selected, try another and then preview it. Repeat this process until you find one that you like.  I like the US English - Green one.
14 Close the browser window.
15  Save your work. Office Button > Save or (Ctrl + S)
This completes Exercise 4, modifying the look of the “Earthquakes-1” web site.

Any Questions?

Exercise 5 – Applying Text Styles

Tip: To select a paragraph in Word, put the cursor in the left margin and double click. Or triple click from within any paragraph.
Apply the cgBoxText style
To give this text special emphasis:

1 Select a paragraph just below the heading Earthquakes and apply the cgBoxText style. 

Apply the cgPanelText style

To give this text special emphasis:

1 Select a paragraph just below Origin of Earthquakes and apply the cgPanelText style 

Apply other styles to some other paragraphs

To do this:

1 Select the paragraph just below the heading Glaciers. 
2 Apply the cgQuoteText style to it.

3 Select the paragraph just below the heading The Formation of Glacial Ice 
4 Apply the cgLiteral style to it.

Look at your changes

1 Generate the course and 
2 Preview the modified pages.
3 Close the browser window.
4 If you do not like the text style you selected, try another and then preview it, or
5 If you want to remove the style, select the item then select the item with a style applied then select Clear All from the Styles panel.
6 Generate any further changes, preview, then close the browser window

7 Save your work. Office Button > Save or (Ctrl + S)
Apply the Definitions style

You can use the cgDefinitions style to give a consistent appearance to all your definitions in your document. This is slightly different from the previous styles: your selection must have two parts:

1 The term to be defined as the first paragraph, followed by 
2 The full definition of the term in a second paragraph. 
You then have to select both the term and its definition together and then apply the cgDefinition style to both parts together.

To do this:

1 Locate the paragraph under the heading Definition of a glacier.

2 The definition is already there, so we want to add the term above it,
3 Insert a new blank line above the paragraph “A glacier is a permanent…”, and type the word Glacier on the new blank line.
4 Select both paragraphs “Glacier” and “A glacier is a… pull of gravity”.
5 Apply the cgDefinition style to both parts.

6 Generate the course and preview the changes.
It should look like this:

Definition of a glacier
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We’ll come back to use the definition of Glacier later. We will link to it from another part of the document.
This completes Exercise 5, Applying Text Styles.

Any Questions?

Exercise 6 – Checking Tables
Accessibility point: People with sight impairment often use screen reader software to read out loud the text of web pages. If header formats are applied to the row and column headings of a table, the screen reader can make sense of the table data and read it out in a much more informative way.
Turn on accessibility checking
We strongly recommend that the Accessibility Checking Feature always be on. Never turn it off.

With accessibility checking turned on, Course Genie will automatically carry out checks on tables and images each time you generate a course. If it finds errors, it will stop and prompt you for corrections. With this feature turned on, you will not be able to generate new or updated web pages containing accessibility errors. 
Some “fixes” are beyond the capabilities of Course Genie and Word. If you can not fix the problems with these tools, you will need to either reconstruct the way the information is presented or contact your technical support staff for assistance.
To do this:

1 Go to the Add-Ins Tab, click the CourseGenie command and choose Settings.

2 In the Settings dialog box, choose the Accessibility tab.
3 Make sure there is a check mark in the box in front of Carry out accessibility check before generating course.
4 Always place a check mark for the Image alt text
5 Always place a check mark for the Image long descriptions
6 Always place a check mark for the Table Headers
7 You may also select the others if they apply to your work.
8 Click OK to close the dialog box.
Now when try to generate the course. You should find that Course Genie stops and warns you that the table has no header formatting, and stops before generating the course.

Try it. See what happens. Generate the Course: 
1. Add-Ins tab > CourseGenie command menu > Generate the course…

2. An Accessibility Alert should be generated.
3. Click on the Cancel button.

Now, Lets fix the problem
Apply table header formatting
To apply header formatting to the table:

1 Locate the heading Glacier Speeds.  Following it is a table that contains the error(s).
2 Select the top row of the table and apply the cgTableColumnHeader style.
3 Select the bottom four cells of the first column of the table and apply the cgTableRowHeader style.
4 Generate the course and preview the changes.
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Info: Course Genie cannot convert tables that contain merged cells. If you have tables with merged cells you will need to redesign them before generating a course or obtain assistance from your technical support staff.
This completes Exercise 6, Checking Tables.

Any Questions?

Exercise 7 – Adding Images - and their descriptions
Images can greatly enhance the message you want to convey. However, to many images, images in the wrong location, inappropriate images, and distractive images may distract or cause the reader to skip over the content or to leave the web page.
For images to be meaningful to persons with disabilities, usually sight impaired with loss of vision or color blindness, they must use a mechanism that will “describe” the image to them.

To comply with accessibility requirements, each image must have a description associated with it.

The description may be in the form of either an Alternative Text (Alt Tag) if it can be described in ten words or less or a Long Descriptions if it requires more than ten words to describe it. The exception is that images that are used solely for decoration (i.e., non functional) do not require a description, but they do require an empty “Alt Tag”.

Inserting images
Now we’ll insert three images into the document.

To insert the first image:

1 Locate the paragraph headed by Origin of Earthquakes. 
2 At the end of the paragraph there is a place holder where the image (origin_earthquakes.gif) is to be inserted.
3 Select the line (origin_earthquakes.gif) by highlighting it.

4 From the Word Insert menu item choose Picture 
5 Navigate to Desktop / CourseGenie/ sample_images and select the origin_earthquakes.gif then click Insert.

6 The image should now be inserted in the document.

To insert the second image:

1 Locate the paragraph headed by Seismology, The Study of Earthquakes. 
2 At the end of the last paragraph there is a place holder where the image (seismograph.gif) is to be inserted.

3 Select the line (seismograph.gif) by highlighting it.

4 From the Word Insert menu item, choose Picture 
5 Navigate to Desktop / CourseGenie/ sample_images and select the seismograph.gif then click Insert.

6 The image should now be inserted in the document.
To insert the third image:

1 Locate the paragraph headed by Types of Seismic Waves.
2 At the end of the first paragraph there is a place holder where the image (seismicwaves.gif) is to be inserted.

3 Select the line “(seismicwaves.gif)” by highlighting it.

4 From the Word Insert menu item, choose Picture 
5 Navigate to Desktop / CourseGenie/ sample_images and select the seismicwaves.gif then click Insert.

6 The image should now be inserted in the document.
Now, try to generate the course. You should find that Course Genie stops and warns you that the images have no Alt text, and stops before generating the course. Cancel the warning message.
Accessibility point: You should always add Alt text to your images. Some browsers present the Alt text visually, others don’t (IE doesn’t, Firefox does). However, the Alt text will always be read out loud by all screen reader software.

Adding Alt text to the images
Alt text for the first image:
1 In Word, locate the origin_earthquakes.gif image at the end of the paragraph Origin of Earthquakes.

2 Right-click on the image
3 Select Format Pcture… 
4 Choose the Alt Text tab
5 Type the description, Graph showing the bending of rocks into the text box.

6 Press Close.

Alt text for the second image:

1 In Word, locate the seismograph.gif image at the end of the last paragraph Seismology, The Study of Earthquakes.

2 Right-click on the image 
3 Select Format Pcture… 
4 Choose the Alt Text tab
5 Type the description, Seismograph into the text box.

6 Press Close.
Alt text for the third image:

1 In Word, locate the seismicwaves.gif image at the end of the first paragraph Types of Seismic Waves.

2 Right-click on the image 
3 Select Format Pcture… 
4 Choose the Alt Text tab.
5 Type the description, Types of Seismic Waves into the text box.

6 Press Close.

Generate the course and preview the pages with the images.

Note: You may get a message stating that the image may need a long description. If you do, modify the Alt Text to include a Long Description. To do this:
1 Right-click on the image 
2 Select Format Picture… 
3 Choose the Alt Text tab
4 After the alt text that you entered earlier, press the Enter key twice then add a more detailed description of the image.
Note: this will add a “D” link to right side ig the images on the web pages.
Generate the Course

After generating the course, hold the pointer over the image. Does the Alt text appear? In some browsers it does, in others it doesn’t. But, remember, it’s not for the sighted. It’s for the visually impaired. They will “hear” it no matter which browser they are using.
Accessibility point: Alt text is usually a brief one-line description of an image. If you are using complex images or diagrams, a brief description may not be enough to convey the meaning of the image. In these situations you can add a long description of the image (sometimes called a “D-Link”) which adds a hyperlinked letter “D” leading to a separate page that shows a full detailed description of the image.

Adding long descriptions to the images
Note: You may have already done this above. If so, skip to the end of Exercise 7.
Sometimes images cannot be described briefly (usually less than 10 words). Images like maps, mathematical formula, organization charts, etc. may need a much more detailed description to convey the message. We use a Long Description rather than an Alt Text for these types of images.

The way Long Descriptions work is different than Alt Text. They do not appear when the pointer hovers over the image. The Long Description text is actually placed on a separate web page. A link to the Long Description web page is usually placed to the right of the image. We use the letter “[D]” (for description) and making it a link to the Long Description web page. We call the technique - using a “D Link”. The Long Description web page will contain a link back to the main page.
Here’s how to make a Long Description, the link to it and the link back to the main page.

1 Locate the origin_earthquakes.gif image at the end of the paragraph Origin of Earthquakes.

2 Right Click on the image.
3 Select Format Picture… 
4 Choose the Alt Text tab.
5 After the Alt text press the Enter key twice to leave a blank line. 
6 Type This graph shows that the fault line occurs at the point where rocks are bent in different directions.

7 Click on Close to close the dialog box.

8 In the same way add long descriptions to the other two images; seismograph.gif and seismicwaves.gif.
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The results of inserting Long Descriptions

1. Generate the course and preview the pages with the images.

2. Locate the images

3. Notice the [D] link to the right of the image

4. Click on the [D] link

5. The Long Description web page for the image should now open.

6. After reading the Long Description, click on Back to return to the main page.

This completes Exercise 7, Adding Images - and their descriptions.

Any Questions?

Exercise 8 – Adding Hyperlinks:
There are three types of links (hyperlinks) used for jumping from one web location to another; External Links, Internal Links and Bookmark Links.

· External Links (technically, an Absolute Link) are used for accessing resources that live outside of your web site. i.e., you may not own them or manage them and they do not live inside your web site. They may belong to someone else. External links are generally used to link to another web page or resource that is external to your web site. i.e., a web page or resource that is not a part of your web site. The addressing scheme used for external links usually looks something like this – http://www.somewhere.com.  The absolute address is often referred to as a URL or URI.
Note: There are several places in our document that refer to external resources. We’ll be adding external links at these locations. 
· Internal Links (technically, a Relative Link) are used for accessing resources that live inside of your web site. i.e., you own them and manage them. They belong to you and live inside your web site. Internal links are generally used to link to another web page or resource that is internal to your web site. i.e., a web page that is a part of your web site.  The addressing scheme used for internal links usually looks like this  ../../webpage.html. 
Note: In this workshop, each time you Generate the Course that has resulted in more than one web page, Course Genie inserts the necessary navigation (the left navigation bar, and the back, home and next buttons) that provide the user the necessary links to move between the pages.  These are Internal (Relative) links because all of the resources (web pages, images, etc.) live within the web site.
· Bookmark Links (technically, an Anchor Link) are generally used to jump from one location to another specific location within the same or another web page. i.e., skip from one part of the web page to another part of the same web page or a specific location within another web page.  The addressing scheme used for bookmark or anchor links usually looks like this  #anchorname. 
Note: We’ll soon be creating a bookmark link to the Definition of a Glacier that we designated as a cgDefinition earlier.
The descriptions above are just a part of a variety of addressing and combinations of addressing schemes that may be used for navigation within web sites. 
Info: The key to inserting links into your documents is knowing where the linked to resource is. i.e., it’s address (URL), the name of the webpage or file or the name of the bookmark / anchor before inserting it into your document lives.  It helps to know where you are going before you try to get there.
Add an external link
To add the first External Link:

1 Locate the section headed by Additional Glacier Resources in the Earthquakes-1.doc document.

2 Just after the text Link to additional Glacier resources press the Enter key to crate ane line, then

3 Type “Use Google to search for glacier resources”.
4 Select the text (external address, URL) on the line below:
http://www.google.com/search?sourceid=navclient&ie=UTF-8&oe=UTF-8&q=glaciers
5 Copy this text (the URL ) - press CTRL-C.

6 Select the Use Google to search for glacier resources text that you just typed in.

7 From the Word Insert menu item, select Links group, choose Hyperlink…
8 Make sure Existing File or Web Page is selected in the left hand column of the dialog box

9 Place the cursor in the Address text box and insert the address (URL) that you just copied. Press CTRL-V to paste the URL from the clipboard.

10 Click on OK to close the dialog box.

11 Generate the course and preview the page
12 Try the hyperlink.

13 When finished, Close the browser window.

14 If the link worked properly, you now can delete the http://www.google.com/search?sourceid=navclient&ie=UTF-8&oe=UTF-8&q=glaciers line, if you want to.  Some people don’t like to leave it in. They think it looks ugly. Others do want to leave it in. They think it’s informative. Others make it the link. It’s a stylistic issue and completely up to you, your client or boss.

Accessibility point: Hyperlinks that take you away from the course material are often set to open in a new browser window. This can confuse screen reader software, and it is better from the accessibility point of view to open hyperlinks in the same browser
              window as the main content.Set the link to open in the same browser window
To do this:

1 Back in Word, go to the CourseGenie commands menu (on the Add-Ins tab) and choose Settings.

2 In the Settings dialog box, choose the Navigation tab.
3 Make sure the Open hyperlinks in main window checkbox is checked.
4 Click OK to close the dialog box.
5 Generate the Course and preview the page with the hyperlink.

Tip: It’s a good idea to make sure that hyperlinked text is a meaningful description rather than just a URL. Avoid using “Click here”.
To add the second External Link:

1 Locate the section headed by Flash Animation of an Earthquake in the Earthquakes-1.doc document.

2 Find the very last sentence in the section This animation downloaded from
3 Highlight text of the URL on the next line http://quake.wr.usgs.gov/research/deformation/modeling/animations/
4 Make it a link by using one of the following methods:

5 One - If it is already a link, do nothing. Word recognized it as a web addressing scheme and made it a link for you. Easy enough. Skip to Step 13 below.

6 Two- If it is not already a link, go to the end of the line, just after the last /, and press the space bar. Word should now recognize it as a web addressing scheme and make it a link for you. Easy enough. If it did, skip to Step 13 below.
7 Three - Copy the text (the URL).

8 Select the http://quake.wr.usgs.gov/research/deformation/modeling/animations/ text. press CTRL-C to copy it. 
9 From the Word Insert menu item, select Links group, choose Hyperlink…
10 Make sure Existing File or Web Page is selected in the left hand column of the dialog box

11 Place the cursor in the Address text box and insert the address (URL) that you just copied. Press CTRL-V to paste the URL from the clipboard.

12 Click on OK to close the dialog box.

13 Generate the course and preview the page

14 Try the hyperlink.

15 When finished, Close the browser window.


Info: To remove a link, highlight the link then, from the Word Insert menu item, Link, choose Hyperlink… then click on the Remove Link button at the right end of the Address: box.
Add an internal (bookmark / anchor) link
You can link from one location in your document to another location in the same document by using a bookmark (anchor) as the destination. It’s a two step process. For this to work, the bookmark (anchor) must be defined and a link to the bookmark established.

Info: If the destination is within the same generated web page, Course Genie will insert a Bookmark (Anchor) link. If the destination is inside another web page (but within the same web site), Course Genie will insert an Internal (relative) Link with the 
     name of the Bookmark (Anchor) appended.
To define the bookmark (anchor) do this

1 Locate the heading Definition of a glacier
2 Insert a line just below the heading Definition of a glacier and just above the word Glacier, type GlacierDefinition (this will be the name of the bookmark). Be sure this is not inside the cgDefinition formatting. 
3 Press Enter 

4 Select the word GlacierDefinition. The one you just typed in. 
5 From the Insert menu item, select Links then choose Bookmark
6 For the Bookmark name:, type GlacierDefinition (again) in the dialog box, then 
7 Click on the Add button
8 The text [GlacierDefinition] appears in the text. 
Notice the square brackets. This indicates it’s a bookmark.
This completes defining a bookmark (anchor).
To insert a link to the bookmark (anchor) do this:

1 Locate the heading The Formation of Glacial Ice.

2 At the end of the paragraph, press Enter twice to insert a blank line then 
3 Type Remember the definition of a glacier?.
4 Select the text Remember the definition of a glacier? that you just typed in.
5 Now to add a link to the [GlacierDefinition] bookmark
6 From the Insert menu item, choose Hyperlink…
1 In left column of the dialog box choose Place in This Document
2 In the main area, from under the Bookmarks category, choose the bookmark called GlacierDefinition
3 Click OK
7 Generate the course and preview the page with the bookmark link.
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This completes Exercise 8, Adding Links.

Any Questions?

Exercise 9 – Adding multimedia (Bonus Exercise)
If we are running short on time this can be a bonus exercise that you can do on your own.
There are several types of multimedia (audio, visual, movies) that can be added to web pages through Course Genie. These include Flash, RealAudio, RealVideo, WindowsMedia and QuickTime media. 

For this exercise, we will be adding a Flash movie. 
To do this:

1 The CG Tools tool bar must be turned on to insert multimedia.

2 If Course Genie is not running, start it - select the Add-Ins tab / Course Genie / Start Course Genie.
3 Additional CG Tools are available on the Add-Ins Tab. Look to the right of the vertical separator bar in the Add-Ins group. Look for the Interaction option to verify that all tools are available to you.
Note: If Course Genie is not running, these tools will not be available.
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4 In the document, place the pointer where you want the Flash movie inserted. For this exercise select the (seismcity_animation.swf) place holder on the next to the last line of the section that begins with the Flash Animation of an Earthquake heading. The last part of the document.
5 With the (seismcity_animation.swf) place holder highlighted, from the CG Tools, select the Interaction option.
6 From the Interaction option, select Media…. The Course Genie Media Builder dialog box will open.
7 From the Course Genie Media Builder dialog box, select the Media Tab.
8 Under Type, select Flash
9 Under File, click on the Browse button.

10 Browse to the Course Genie folder on your Desktop, select the Media Samples folder and select the seismicity_animation.swf Flash movie.
11 Leave the Display to the default settings. You can change these later if you want to.

12 Now, a very valuable and important step. And required at NC Sate to meet the minimum accessibility requirements.
13 Back at the top of the Course Genie Media Builder dialog box, select the Accessibility tab.

14 For the Long Description, type in Simulation of the pressures building in a seismic active area from 1975 through 2001. More, if you want.
15 For the Caption, type in Seismic Pressure Simulation.
Note: If you want to insert an option for the user to download the media player, place a check mark in the box provided. Most modern web browsers already have media players installed. But, it never hurts to give them the option.
16 Click OK.

17 Course Genie will place the information in your document that it needs to produce the necessary code to include and activate the media. It looks similar the Metadata information inserted earlier. Like the Metadata, it will not be visible in the web page. Also, like the Metadata, you can edit the information directly in the document.
18 Save your work (CTRL + S)

19 Generate the Course

20 Preview the updated web pages in a browser. 

21 Go to the Flash Animation of an Earthquake topic.
22 Click on the image to start the movie.
Note: Each of the red lines o the timeline bar on the left are stopping points for the movie. Just click on the movie again the start it moving to the next red line.

On the line following the Flash movie is a link (that we put in the page earlier) to a web page that contains additional movies that you can play or download.

This completes Exercise 9, Adding multimedia.

Any Questions?

We are finished with the Course Genie part of the workshop.

1 Stop Course Genie.

2 Close Word.
3 Close any other applications.

4 Be sure you can see the CourseGenie folder on your Desktop.

5 Now let’s look at the folders and files that were created today.

6 And, let’s look at the two new web sites through the Internet.

Exercise 10, Looking at the results.
Now let’s:

A Look at the content in the CourseGenie folder on your Desktop
B Copy the CourseGenie folder to your personal AFS web space 

C Use a web browser to view the web pages you created today through the Internet.

Exercise 10A - Look at the contents in the Course Genie folder on your Desktop
To do this:
1 Close all applications that you have open.

2 You should now see your Desktop.

3 Double click on the CourseGenie folder
Let’s examine the content of the CourseGenie folder.

· You should see all of the original documents that we started with at the beginning of the class. Including the Weather.doc the Earthquakes.doc and the handout-new.doc and others.

· You should also see the folders and files that you created today.
Including the Weather-1.doc and the Earthquakes-1.doc.

· You should also see the folders and files that Course Genie created.
Including the Weather-1 folder (containing all of the Weather-1 web pages) and the Earthquakes-1 folder (containing all of the Earthquakes-1 web pages).
· In addition, there should be a Weather-1_HTML.zip folder and an Earthquakes-1_HTML.zip folder.
Course Genie automatically created these two “.zip” folders for you so that you will have a portable copy of your web sites. If you wanted to send someone a copy of your web sites, all you have to do is attach these zipped files to the email recipient. Or, if you wanted to install a copy of your web sites on another computer, all you have to do is copy these zipped files to the new computer and unzip them to install the complete web sites on another computer. 
Notice: The Weather.doc and the Weather-1.doc are not included inside the Weather-1 folder and the Earthquakes.doc and the Earthquakes-1.doc are not included inside the Earthquakes-1 Folder. If you want to keep a complete set of all the related files together, you might want to move or copy, these documents into their respective folders.
Any question about what is inside of the Course Genie folder on your Desktop? Or how it got there? It’s really important that you know where all of your resources are located.
Exercise 10B - Copy the CourseGenie folder to your personal AFS web space

To do this:
1 Open My Computer (AFTnn) – if not still open.
2 Select your K: drive. It’s the drive that begins with your unity ID and ends with (K:).
Note: be careful not to select your (M:) drive.
3 With your K: drive selected, find the WWW folder.
4 Now, find and select the Course Genie folder on your Desktop (single click on it). 

5 Drag the CourseGenie folder from your Desktop to the WWW folder on your K: drive.
You have just copied the CourseGenie folder (including all of its contents) into the WWW folder on your K: drive. It’s now on a web server and available for viewing through the Internet.
We no longer need the CourseGenie folder on the Desktop. 
1 Drag the CourseGenie folder on your Desktop to the Recycle Bin.
Note: If you have any applications open that are using any of the files in the CourseGenie folder, it may not allow you to put it in the Trash Bin. Close the applications and try again. 
Exercise 10C - View the web pages you created today through the Internet using a web browser

So far, we have looked at “local” copies of the web pages, the copies in the CourseGenie folder on your Desktop. Now that we have moved them to the web server, let’s look at them on the web server through the Internet.
However, before we look at the web sites we created today, let’s take a minute to review a couple of items. How do web browsers find web pages in general? And, how to tell the web browser to find the specific the web pages Course Genie created for me today?
How do web browsers find web pages? Several ways, lets look at just a few.

· One way is to open a web page is from a link in a web page. All you have to do is click on the link.

· Another way is for you to place the full web address (URL) into the address box in the web browser. If you know the full address of the specific web page (file) that you want to open, all you have t do is type it in the address box then press Enter (or select the “Go” button) to go directly to the file (web page). Some browsers can help you. For example, if you forget to put in the “http//” or the “www”, some of them will do it for you.
· Yet another way is to let the browser help find the first (Home) page in a web site. If you know the name of the web site (for example http://www.ncsu.edu), but don’t know the name of the specific file (web page) that you want to go to (there are several million web pages at http://ww.ncsu.edu, how are you supposed to know which one is the “Home” page.), modern browsers can help find the home page. In the browsers address box, if you specify a web site, but not a specific web page (file), the browser will automatically look for the web site’s home page, a page that has “index.” in its name. i.e., index.htm, index.html, index.php, index.asp, etc. The first page that it finds that has “index.” in its name will be opened. From there you can navigate to any other page in the web site. This is why we generally name the first page of a web site “index”. 
· When Course Genie created our two web sites today, the home page in each web site was named “Index.html”.
Use a web browser to view the specific web pages you created today through the Internet 

Up to now, we have used the web browser to view the web pages that are on your Desktop (preview in browser). Now, that we have moved them to a web server, let’s look at them through the Internet.

How do I tell the web browser how to find the web pages Course Genie created for me today?

To do this:

1 First of all, you have to know where the web pages are. Where do they live?
2 We know that theWeather-1 and the Earthquakes-1 web sites are inside the CourseGenie folder. Remember, that’s where we saved them to during the exercises.

3 Second, we know that the CourseGenie folder now lives inside the WWW folder on your K: drive. Remember, we moved it there just a few minutes ago.

4 Third, how do I tell a web browser to get to my K: drive? Use the address http://www4.ncsu.edu/~yourunityid. Remember, when we ran the WWW Setup Utility, it told us that your Internet URL was http://www4.ncsu.edu/~yourunityid. The WWW Setup Utility also makes sure that all request from the Internet to be directed to the WWW folder inside your K: drive. Remember, we don’t want anyone to see any of the other files located outside the WWW folder. So, the files outside the WWW folder are not available from the Internet.
5 Open a web browser. Let’s use Firefox this time. It’s in the Novell Applications Launcher (NAL).
6 With Firefox open, type in http://www4.ncsu.edu/~yourunityid then press Enter.

7 What web page opened? It should be your personal home page. Or if you didn’t have one before, it will be the web page that the WWW Setup Utility created for you. Its file name should be “index.html”. 
8 Why did it pick this page? Remember, since we did not specify a specific web page (file) it automatically looked for the first page inside the WWW folder with “index.” in its file name. So, it looked inside the root of your WWW folder and opened the first page that it found with “index.” in its name. So it opened http://www4.ncsu.edu/~yourunityid/index.html.
9 But, I want to open the Weather-1 web site. How do I do that?

10 Where does the Weather-1 web site live? Inside the CourseGenie folder that is inside your WWW folder.
11 So, you have to tell the browser to look deeper into the WWW folder. 
The URL to the Weather-1 web site will be
http://www4.ncsu.edu/~yourunityid/CourseGenie/Weather-1. Press Enter
Note: If it didn’t work - did you remember that the “C” and the “G’ in CourseGenie and the “W” in Weather-1 are capitalized? Web servers are often case sensitive. NC State’s ITD web servers are set up to be case sensitive.
12 What page opened? The first page with “index.” in its name 
(Weather-1/index.html).
13 Now, you, and anyone else on the Internet, should have access to your Weather-1 web site that you created today.
14 Now, I want to open the Earthquakes-1 web site. How do I do that?

15 Where does the Earthquakes-1 web site live? Inside the CourseGenie folder that is inside your WWW folder.

16 So, you have to tell the browser to look deeper into the WWW folder. 
The URL to the Earthquakes-1 web site will be
http://www4.ncsu.edu/~yourunityid/CourseGenie/Earthquakes-1. Press Enter
Note: If it didn’t work - did you remember that the “C” and the “G’ in CourseGenie and the “E” in Earthquakes-1 are capitalized? Also Earthquakes is plural. Earthquakes-1 has an “s” at the end. 

17 What page opened? The first page with “index.” in its name 
(Earthquakesr-1/Index.html).

18 Now, you, and anyone else on the Internet, should have access to your Earthquakes-1 web site.

This completes Exercise 10 and all of the exercises for today’s workshop.

Any Questions?

Finishing the Workshop

1 Please fill out the Online Workshop Evaluation at:
http://itd.ncsu.edu/education/evaluation/ or
double click on the Workshop online evaluation icon on your Desktop.
Note: You’ll need to login using your Unity ID / Password.
2 After completing the evaluation, 

3 Close any applications that remain open

4 If you haven’t already done so, Drag the CourseGenie folder on your Desktop to the Recycle Bin.

5 Log Out using the (RED) Logout icon on the desktop.

6 Do NOT turn the computers off. We keep them powered on at all times.

Thank you for attending this ITD workshop. 
We look forward to seeing you in future workshops. 
See our schedule at:
http://www.ncsu.edu/it/education/faculty-staff/schedule.php 
If you have any questions, contact us at classreg@ncsu.edu
Appendix A

Tips for using MS Word to create content to be converted in Course Genie


· Do keep lists simple (i.e. try not to mix images etc. in bulleted text sections)

· Don't use merged cells in your data tables!!

· Do convert all Drawn images (arrows and such) to Painted images

· Do prefix all angle brackets (< or >) with a tilde (~) before creating site in CG

· Don't use tabs and indents for layout

· Don't use empty paragraphs for vertical layout (Use Shift + Enter)

· Don't run bold or italic formatting across table or list boundaries

· Leave blank lines above and below tables
· Try not to nest lists more than two deep
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